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Preface 

This manual provides information regarding the Patch 1 release of the Dental/EDR 
BADE Interface with RPMS. This patch includes the following updates to the Dentrix 
interface software.  

• Patient merge upload options 

• Option to send an A40 message 

• New menu options for troubleshooting 

• More detailed alert messages 

• A fix to ASUFAC-HRCN alert issue 

• A manual purge option 

• Migration of BEE software to BADE namespace 

• Support of clinic names in the FT1 segment of the DFT 

• Several improvements to user interface prompts 
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1.0 Release Notes 

1.1 Patient Merge 
This patch includes functionality for sending HL7 messages from RPMS to notify 
EDR of merged patients. The information sent allows for merging of the identical 
patients in the EDR database. The message type for merge records is the A40. An 
A40 message contains data from the merged-to patient plus an MRG segment, which 
contains the DFN and the name of the merged-from patient. This is the only 
remaining data on the merged-from patient. 

The patch includes menu options for sending A40 messages on any patients that have 
been previously merged. There is also an option to manually send an A40 message. If 
a site has installed the dental interface prior to patient merge, all merges will be 
handled automatically through protocols attached to the patient merge process.  In 
order for the automated merge process in RPMS to notify the Dental system of a 
patient merge, Patient Merge BPM patch one must be installed.  If Patient Merge 
Patch 1 is not installed prior to EDR Dental BADE Patch 1, the EDR Dental BADE 
Patch 1 will disable the BADE Merge Menu options during its installation.  The site 
can follow the installation guide to properly activate the BADE Merge Menu options. 

The following are options that have been added to the Dental/EDR BADE Interface 
menus.  

1.1.1 New Option: Upload All Merged Patients 
Internal Name of Menu Options: [BADE EDR UPLOAD ALL MERGED PTS] 

Link: Dental Interface Menu > UPL > MALL 
 

Added to the Dental Interface Upload Menu. This option uploads all merged patients 
in the database. It should only be run by sites that have already installed patient 
merge. This option can be paused and restarted. When the upload is complete, all 
menu options involving upload of merged patients are placed Out of Order. This 
option can be re-run without causing issues with the Dental EDR system. The site 
must reset OUT OF ORDER menu options and edit PARAMETER settings to 
properly reset the UPLOAD option. 

Anyone using this option must be assigned the BADEZUPL key in order to access the 
Dental Interface Upload Menu. 
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1.1.2 New Option: Pause Merge Upload 
Internal Name of Menu Options: [BADE EDR UPLOAD ALL MERGED PTS] 

Link: Dental Interface Menu > UPL > PMRG 
 

Added to the Dental Interface Upload Menu. This option pauses a merge upload that 
is in progress. The merge upload can be restarted.  

Anyone using this option must be assigned the BADEZUPL key in order to access the 
Dental Interface Upload Menu. 

1.1.3 New Option: Restart Merge Upload 
Internal Name of Menu Options: [BADE EDR RESTART MRG UPLOAD] 

Link: Dental Interface Menu > UPL > RMRG 
 

Added to the Dental Interface Upload Menu. This option restarts a merge upload that 
has been halted. A parameter is checked to see if the Merge Upload is already 
running. When the upload is complete, all menu options involving upload of merged 
patients are placed Out of Order. 

Anyone using this option must be assigned the BADEZUPL key in order to access the 
Dental Interface Upload Menu. 

1.1.4 New Option: Send a Patient Merge Message 
Internal Name of Menu Options: [BADE EDR SEND A40] 

Link: Dental Interface Menu > MAN > A40 
 

Added to the Dental Interface Management Menu. This option sends a single Patient 
Merge (A40) message. The user is prompted for the patient. A list of patients is 
displayed that have been merged with that patient. If there are no merged patients, 
this is indicated. An indication is given when the message is sent. 

Anyone using this option must be assigned the BADEZSND key in order to access 
the Dental Interface Upload Menu. 

1.2 Options for Troubleshooting 
Several new options have been added, providing information to aid with 
troubleshooting. Some of these options provide information that can be used to clean 
up files before an upload. 
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1.2.1 New Option: Dental List 
Internal Name of Menu Options: [BADE EDR DISPLAY PROVIDER] 

Link: Dental Interface Menu > MAN > PRO 
 

Added to the Dental Interface Management Menu. This option displays a list of dental 
providers in the database, along with their NPI and IEN numbers.   

The display can be run for all dental providers or only those who are active. Active 
providers are those who have not been terminated or inactivated, and who have an 
NPI number.  

Anyone using this option must be assigned the BADEZSND key in order to access 
the Dental Interface Management Menu. 

1.2.2 New Option: Display Dental Visit ASUFACs 
Internal Name of Menu Options: [BADE EDR DENTAL ASUFAC] 

Link: Dental Interface Menu > UTIL > ASU 
 

Added to the Dental Interface Utilities Menu. This option displays the number of 
visits for each facility within a specific time period. The user may specify the start 
date of the search. The end date is the current date.  

Anyone using this option must be assigned the BADEZUTL key in order to access 
the Dental Interface Utilities Menu. 

1.3 BEE Options Migrated to BADE 
When BADE was initially certified and released as a nationally supported package, 
the enterprise messaging architecture had defined the RPMS BEE namespace to be 
used for common library utilities, routines, and files in support of the architecture. 
Since that time, OIT has modified the architecture, and each application is responsible 
for all components to support the interface. In this patch, RPMS BEE routines, files, 
and options are converted to the BADE namespace and package. The BADE Visit 
filer calls the HLO HL7 messaging software to parse the DFT message and properly 
create a PCC Visit. In order for this HLO filer to work, the EDR Dental system must 
modify the DFT MSH segment. This is done by calling the Dentrix Help Desk. 

1.3.1 New Option: Reset an HLO Message for EIE Transport 
Internal Name of Menu Options: [BADE EDR DISPLAY PROVIDER] 

Link: Dental Interface Menu > UTIL > RES 
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1.3.2 New Option: Process a Single Inbound HLO Message 
Internal Name of Menu Options: [BADE EDR PROCESS INBOUND MSG] 

Link: Dental Interface Menu > UTIL > INB 

1.3.3 New Option: Dental Interface Trace 
Internal Name of Menu Options: [BADE EDR TRACE] 

Link: Dental Interface Menu > UTIL > TRC 
 

Added to the Dental Interface Utilities Menu. This option will work in conjunction 
with the Ensemble Interface Engine (EIE) to help trace message transmission.   

The option provides a way for turning on and off the EIE Trace function, by setting a 
Mumps global. The trace can be done for inbound or outbound messages. If the trace 
is currently running, this option can be used to turn the trace off. Otherwise the option 
can be used to start the trace. 

It is extremely important that the trace only be used for several minutes while active 
troubleshooting is in process. Having the trace on can seriously slow down the system 
and fill up disk space. 

Anyone using this option must be assigned the BADEZUTL key in order to access 
the Dental Interface Utilities Menu. 

1.4 Modified Alert Messages: More Details 
The usefulness of error messages was limited by the amount of information that was 
included. In some cases, there was not enough information to conveniently identify 
the patient or provider message causing the error. 

Changes were made to the alert messages to add information, such as patient name, 
DFN, message IEN, ASUFAC number, visit date, visit IEN, and provider name 
where appropriate. 

The following routines were modified:  

• BADEHL1 

• BADEHL2 

• BADEHL3 

• BADEHL4 

1.5 Modified Alert Messages: Extra Alert Removed 
Extra alert messages were being sent on error conditions, as follows: 
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Msg IEN: 908 TRANSMISSION LINK FOR APPLICATION ACK CANNOT BE 
DETERMINED 

It was determined that this second message response to an application ACK for the 
original alert. This second alert has been removed by commenting out this line in 
BADEHL3: 

;I '$$SENDACK^HLOAPI2(.ACK,.ERR) D NOTIF(HLMSGIEN,ERR) Q 

1.6 Modification to Fix Error on Patient Upload 
In several cases, the Patient Upload went into an infinite loop. It has been determined 
that this was occurring for patients who were in the ^DPT global, but not in the IHS 
PATIENT file: ^AUPNPAT global. 

Routine BADEEVNT has been modified so that if a patient was not found in the IHS 
Patient file, no message will be sent. In addition, if the patient did exist in the IHS 
Patient file, but did not have ASUFAC entries, no message will be sent. This avoids 
the infinite looping. 

The following is the code: 

K PATNO 
S PATNO=$P($G(^AUPNPAT(DFN,0)),"^",1) 
Q:PATNO'=DFN 
S PATNO=$G(^AUPNPAT(DFN,41)) 
Q:PATNO="" 

1.7 Modification to Fix ASUFAC-HRCN Error 
In some cases, an incorrect DUZ(2) environment variable was being used by the 
BADEHL1 routine on generating A28 and A31 messages. This DUZ(2) is used in 
turn to obtain the ASUFAC and patient HRCN number, which are transmitted in PID-
3. 

It was determined that this problem occurred in multi-divisional sites when several 
registration clerks were working simultaneously. The AG trigger that sends the 
message occurs when a registration clerk exits the whole menu. At that point, the 
registrations entered by all of the clerks are retrieved from the temporary global and 
sent with the DUZ(2) of the clerk who has exited the menu. This results in attempting 
to match a patient with the wrong division. 

This is an error in the PIMS AG system and can affect systems other than Dentrix. In 
the meantime, a modification was made to BADEHL1 to circumvent the potential 
problem. PIMS AG patch has been released to now pass the correct division when 
triggering an ADT message to Dentrix 
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1.8 Modification to Option: Set Default Time for Dental Visit 
Internal Name of Menu Options: [BADE EDR DEFAULT TIME] 

Link: Dental Interface Menu > MAN > DTI 
 

This menu option previously allowed anything to be entered for the default time of 
the dental visit. The parameter was set up as free text, with no validity checking. 
Checking was added so that only valid times in military format are allowed. 

1.9 Modified Out of Order Messages: Upload Menu 
When the Patient Upload is complete, all of the associated menu options need to be 
set to Out of Order. This is similar with Provider Upload and Patient Merge Upload. 
The original version placed only the Upload and Restart menu options Out of Order. 
The current patch places the Pause menu options Out of Order as well as the two 
Throttle options, for Patient Upload. 

1.10 New Option: Manual Purge EDR HL7 Messages 
Internal Name of Menu Options: [BADE EDR MANUAL PURGE] 

Link: Dental Interface Menu > MAN > PUR 
 

Added to the Dental Interface Management Menu. Since the normal HLO purge of 
old messages is sometimes disabled, it was determined that there was a need for 
independent control of this function. This menu options only purges those messages 
that are tagged as DENTRIX. The user may specify how many days’ worth of 
messages they want to retain with the initial prompt. 

Anyone wanting to use this option must be assigned the BADEZSND key in order to 
access the Dental Interface Management Menu. 

1.11 Modification to Inbound Messaging: Assigned Clinic for 
Visits 
Inbound messages from Dentrix create entries in the VISIT File. Each visit has an 
associated clinic (HOSPITAL LOCATION – File 44). The clinic is derived from the 
inbound Dentrix message in one of two possible ways: 

• Piece 2 of FT1-16 may specify the name of the clinic. The name is verified in the 
HOSPITAL LOCATION file. If there is no exact match, then a warning is 
generated and method 2 is used to derive the clinic. Otherwise, the location 
(INSTITUTION – File 4) for that clinic is retrieved. If there is no location, a 
warning is generated and method 2 is used. Otherwise, the specified clinic in 
piece 2 of FT1-16 is used for the visit, with its associated location. 
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• If Piece 2 of FT1-16 is null or any of the 2 warning conditions exist, the clinic is 
derived from the default dental clinic for that location (LOCATION – File 
9999999.06). This can be set in the menu option: Set Default Clinic (BADE EDR 
DEFAULT CLINIC). The location is derived from the ASUFAC, coming from 
either piece 1 of FT1-16 or the first 6 characters of PID-3, with piece 1 of FT1-16 
having precedence. If there is no location associated with the ASUFAC, or no 
default clinic associated with the location, then an error is generated. Otherwise, a 
final check is made to verify that the location derived from the clinic is identical 
to the location derived from the ASUFAC.  

With these modifications, the dental staff will be able to select any of the dental 
clinics defined for the dental encounter and not be limited to RPMS registered 
locations. RPMS and Dentrix servers must define clinic names that match 
identically, including case. The names should be 30 characters or less and be all 
uppercase. 

It is advised that the site use a naming convention to identify HOSPITAL 
LOCATION (clinic) names that allow the RPMS operators to separate these 
clinics from those normally used in scheduling as well as being easily identified 
in the Dental Clinic selection process. As an example, start all of these clinics 
with EDR as in EDR SELLS SCHOOL or EDR TRIBAL OFFICE. 
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2.0 Installation Notes 
Prefix: BADE 
Current Version: 1.0 patch 1 

 

Note: Read the entire file prior to attempting any installation! 

2.1 General Information 
This patch includes the following updates to the Electronic Dental Record (EDR) 
interface software: 

• RPMS has released the Patient merge software. This BADE patch supports an 
automatic trigger and supporting HL7 messages to notify and update the Dentrix 
Enterprise Software with merged patient information. The patch includes Patient 
Merge upload options. 

• The BADE alerts have been modified to display more meaningful alert 
information and the ACK alert message has been removed. 

• There are new menu options for troubleshooting, and startup reports to help 
define the initial setup of EDR. 

• Large sites have been reported to ASUFAC-HRCN alert issue which has been 
corrected for both the initial patient upload and registration process. This better 
supports multi-divisional and unified database defined sites. 

• A manual purge option has been added to allow large sites to purge old HL7 
messages. 

• The RPMS PCC filer has been migrated from the generic BEE to the BADE 
namespace. 

• This patch supports multiple clinic (Hospital Location) names associated with the 
same ASUFAC (Location Encounter) in the PCC Visit. 

• There are several improvements to user interface prompts. 

• There is a new BADE file associated with this patch however, the file is not 
currently used by the package. The file will support future BADE patches. 

2.2 Contents of Distribution 
File Description 

bade0100.01k KIDS file 

bade0100.01n Installation Notes file (this file) 
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2.3 Required Resources 
BADE*1.0 

2.4 Before You Begin: Installation Issues 
The patch does require a KIDS installation, an Ensemble Integration Engine update, 
and modifications to the Dentrix Enterprise Software setup tables to properly work. 

BPM Patient Merge patch 1 may be installed after the installation of BADE Patch 1 
to support automatic triggering of merge messages to EDR. If installed after BADE 
patch 1, a documented post initialization can be run to activate the EDR merge 
process. (See Post-Install instructions in section 3.0) 

2.5 Routines in BADE*1.0*1 
BADEASU New - Utilities from BEE namespace 

BADECTR2      New - Utilities from BEE namespace 

BADECTRL New - Utilities from BEE namespace 

BADEECP1 Pre and post installation for patch 1 

BADEHL1 Modified alert messages and fix with registration DUZ(2) 

BADEHL2 Modified alert messages 

BADEHL3 Modified alert messages, Clinic (Hosp Loc) names support 

BADEHL4 Modified alert messages, Clinic (Hosp Loc) names support 

BADEHLI Modified alert messages 

BADEHLZ Modified alert messages 

BADEMRG New - Patient merge functionality 

BADEMRG1 New - Patient merge functionality 

BADEPROV New - Utility to display dentists, manual purge 

BADEPRV1 New - Utility to display dental visits 

BADEVNT1 Modified to mark options out of order 

BADEEVNT Modified to mark options out of order, alerts, patient # fix 

2.6 New options and Security Keys 
There are several new menu options. There are now three top level menus, each with 
its own security key: 

UPL    Dental Interface Upload Menu ... [BADE EDR UPLOAD MENU] 
    **> Locked with BADEZUPL 
MAN    Dental Interface Management ... [BADE EDR MANAGE INTERFACE MENU]  
    **> Locked with BADEZSND 
UTIL   Dental Interface Utilities ... [BADE EDR UTILITIES] 
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    **> Locked with BADEZUTL 

The Dental Interface Upload Menu has the following options and supports the Merge 
Upload process: 

UAP    Load all Patients [BADE EDR UPLOAD ALL PATIENTS] 
PUP    Pause Patient Load [BADE EDR PAUSE PATIENT LOAD] 
RUP    Restart Patient Upload [BADE EDR RESTART PAT UPLOAD] 
UPV    Upload All Providers [BADE EDR UPLOAD ALL PROVIDERS] 
PPV    Pause Provider Upload [BADE EDR PAUSE PROV UPLOAD] 
RPV    Restart Provider Upload [BADE EDR RESTART PROV UPLOAD] 
DSP    Display Progress [BADE EDR DISPLAY PROGRESS] 
MALL   Upload all Merged patients [BADE EDR UPLOAD ALL MERGED PTS] 
     **> Locked with BADEZMER 
PMRG   Pause Merge Upload [BADE EDR PAUSE MRG LOAD] 
     **> Locked with BADEZMER 
RMRG   Restart Merge Upload [BADE EDR RESTART MRG UPLOAD] 
     **> Locked with BADEZMER 
ASU    Active ASUFAC Display  [BADE EDR ASUFAC DISPLAY] 
PER    EDR Patient File Count Errors [BADE EDR PATIENT COUNT ERRORS] 
TCT    Pt Count for Throttle action [BADE EDR THROTTLE CT] 
THR    Throttle Patient Upload [BADE EDR PT THROTTLE] 

The Dental Interface Management Menu has the following options and supports the 
ability to send a single A40 HL7 message. There are also menu options to allow the 
user to manually purge old RPMS HL7 messages: 

A28    Send a Single A28 Message [BADE EDR SEND A28] 
A31    Send a Single A31 Message [BADE EDR SEND A31] 
MFN    Send a Single MFN Message [BADE EDR SEND MFN] 
A40    Send a Patient Merge Message [BADE EDR SEND A40] 
     **> Locked with BADEZMER 
REP    Reprocess an Inbound HL7 Message [BADE EDR REPROCESS IN MESSAGE] 
RES    Resend an Outbound HL7 Message [BADE EDR RESEND OUT MESSAGE] 
CLN    Set Default Clinic [BADE EDR DEFAULT CLINIC] 
DTI    Set Default Time for Dental Visit [BADE EDR DEFAULT TIME] 
DPR    Set Default Days for Message Purge Retention [BADE EDR DEFAULT PURGE 
DAYS] 
PRO    Dentist List [BADE EDR DISPLAY PROVIDER] 
PUR    Manual Purge EDR HL7 Messages [BADE EDR MANUAL PURGE] 
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3.0 Installation Instructions 

3.1 KIDS Installation 
Be sure and run the environment checker and double-check to make sure all of the 
patches passed the check. Say NO to rebuilding menus when installing these patches. 

In all UCI's: 

• Load the Distribution into KIDS using option 1 on the KIDS Installation menu. 
The distribution was released in a file named bade0100.01k. 

• Verify the load using option 2 on the KIDS Installation menu. 

• Consider using options 3 and 4 on the KIDS Installation menu to print and 
compare the Transport global. 

• Install the distribution using option 6 on the Installation menu. Sites may wish to 
print out the install for review of errors 

Select Installation Option: 1 Load a Distribution 
Enter a Host File: C:\TEMP\bade0100.01k 
KIDS Distribution saved on Aug 23, 2011@09:29:26 
Comment: BADE EDR Patch 1 8/23/2011  

This Distribution contains Transport Globals for the following Package(s): 

Build BADE*1.0*1 has been loaded before, here is when: 
      BADE*1.0*1   Install Completed                    was loaded on Aug 
23, 2011@09:10:23 
OK to continue with Load? NO// YES 
  
Distribution OK! 
  
Want to Continue with Load? YES// 
Loading Distribution... 
  
Build BADE*1.0*1 has an Environmental Check Routine 
Want to RUN the Environment Check Routine? YES// 
   BADE*1.0*1 
Will first run the Environment Check Routine, BADEECP1 
  
Use INSTALL NAME: BADE*1.0*1 to install this Distribution.  
  
  
    1      Load a Distribution 
    2      Verify Checksums in Transport Global 
    3      Print Transport Global 
    4      Compare Transport Global to Current System 
    5      Backup a Transport Global 
    6      Install Package(s) 
           Restart Install of Package(s) 
           Unload a Distribution  
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Select Installation Option: Install Package(s) 
 
Select INSTALL NAME:    BADE*1.0*1     Loaded from Distribution     Loaded 
from 
Distribution  8/23/11@09:29:48 
     => BADE EDR Patch 1 8/23/2011  ;Created on Aug 23, 2011@09:29:26 
  
This Distribution was loaded on Aug 23, 2011@09:29:48 with header of 
   BADE EDR Patch 1 8/23/2011  ;Created on Aug 23, 2011@09:29:26 
   It consisted of the following Install(s): 
     BADE*1.0*1 
Checking Install for Package BADE*1.0*1 
Will first run the Environment Check Routine, BADEECP1 
  
  
Install Questions for BADE*1.0*1 
  
Incoming Files: 
  
  
   90641.99  BADE ENSEMBLE CONTROL  (including data) 
Note:  You already have the 'BADE ENSEMBLE CONTROL' File. 
Data will NOT be added. 
  
Want KIDS to Rebuild Menu Trees Upon Completion of Install? NO// NO 
  
  
Want KIDS to INHIBIT LOGONs during the install? YES// NO 
  
Enter the Device you want to print the Install messages. 
You can queue the install by enter a 'Q' at the device prompt. 
Enter a '^' to abort the install. 
  
DEVICE: HOME// 
 
  If Merge is not installed:  Patient Merge not Installed 
                             BADE Merge Protocol Not Created 
 If Merge is installed:      BADE Merge Protocol added 
   
           Post Initialization Completed 
  
Install Completed 

Post-install instructions 
e formerly in the BEE namespace have been moved to 

 
 

The tasked options which wer
the BADE namespace. The option [BEE TSK HLO IB MSG FILER] needs to be 
halted. This can be done through the Schedule/Unschedule option in Taskman, and
entering ‘@’ at RESCHEDULING FREQUENCY and SPECIAL QUEUEING. The
option [BADE TSK HLO IB FILER] then needs to be scheduled through the same 
option, with the RESCHEDULING FREQUENCY being 60S and SPECIAL 
QUEUEING:  STARTUP. 
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Select Systems Manager Menu Option: Taskman Management 
  
          Schedule/Unschedule Options 
          One-time Option Queue 
          Taskman Management Utilities ... 
          List Tasks 
          Dequeue Tasks 
          Requeue Tasks 
          Delete Tasks 
          Print Options that are Scheduled to run 
          Cleanup Task List 
          Print Options Recommended for Queueing 
  
Select Taskman Management Option: SCHEDULE 
 
Option Name: BEE TSK HLO IB MSG FILER 
    Menu Text: Task to process HLO msg from EIE          TASK ID: 98631 
_________________________________________________________________ 
  QUEUED TO RUN AT WHAT TIME: NOV 16,2010@13:13 
  
DEVICE FOR QUEUED JOB OUTPUT: 
  
 QUEUED TO RUN ON VOLUME SET: DEV 
  
      RESCHEDULING FREQUENCY: @ 
  
             TASK PARAMETERS: 
  
            SPECIAL QUEUEING: @ 
 
 
Option Name: BADE TSK HLO IB FILER 
    Menu Text: BADE EDR TSK HLO IB FILER                 TASK ID: 
_________________________________________________________________ 
  
  QUEUED TO RUN AT WHAT TIME: NOV 16,2010@14:00 
  
DEVICE FOR QUEUED JOB OUTPUT: 
  
 QUEUED TO RUN ON VOLUME SET: DEV 
  
      RESCHEDULING FREQUENCY: 60S 
  
             TASK PARAMETERS: 
  
            SPECIAL QUEUEING: STARTUP 

The POST Installation of this patch checks to see if the BPM Patient Merge patch 1 is 
installed. If it is not installed then Out of Order messages are set in the Merge Upload 
menu options (see below). If BPM Patient Merge patch 1 has not been installed prior 
to BADE patch 1 then once the BADE patch 1 is installed, the site will need to install 
BPM patch 1 and then RERUN the post init for the BADE patch 1. Below is the 
process to check and redo the post init: 

Check the Dental Interface Main Menu option for the out of order message. 
At the programmer’s prompt: 
TST>D ^XUP 
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Setting up programmer environment 
This is a TEST account. 
  
Terminal Type set to: C-VT100 
  
Select OPTION NAME:    BADE EDR MAIN MENU     Dental Interface Main Menu 
 
   UPL    Dental Interface Upload Menu ... 
   MAN    Dental Interface Management ... 
   UTIL   Dental Interface Utilities ... 
  
Select Dental Interface Main Menu Option: UPL  Dental Interface Upload Menu 
  
  
   UAP    Load all Patients 
   PUP    Pause Patient Load 
   RUP    Restart Patient Upload 
   UPV    Upload All Providers 
   PPV    Pause Provider Upload 
   RPV    Restart Provider Upload 
   DSP    Display Progress 
   MALL   Upload all Merged patients 
             **> Out of order:  Patient merge not installed 
   PMRG   Pause Merge Upload 
             **> Out of order:  Patient merge not installed 
   RMRG   Restart Merge Upload 
             **> Out of order:  Patient merge not installed 
   ASU    Active ASUFAC Display 
   PER    EDR Patient File Count Errors 
   TCT    Pt Count for Throttle action 
   THR    Throttle Patient Upload 
  
Select Dental Interface Upload Menu Option: 

If the Out of Order message shows “Patient merge not installed” as seen above you 
must first install the BPM Patient Merge Patch 1 and after successful completion 
perform the following step at the programmer’s prompt: 

TST>D POST^BADEECP1 
  
A completion prompt for this post init will display.  To verify that the 
Merge options are now available in the BADE menu, do the following at the 
programmer’s prompt and note that the Out of Order messages are removed: 
  
TST>D ^XUP 
  
Setting up programmer environment 
This is a TEST account. 
  
Terminal Type set to: C-VT100 
  
Select OPTION NAME:    BADE EDR MAIN MENU     Dental Interface Main Menu 
  
  
   UPL    Dental Interface Upload Menu ... 
   MAN    Dental Interface Management ... 
   UTIL   Dental Interface Utilities ... 
  
Select Dental Interface Main Menu Option:  Dental Interface Upload Menu 
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    UAP    Load all Patients 
   PUP    Pause Patient Load 
   RUP    Restart Patient Upload 
   UPV    Upload All Providers 
   PPV    Pause Provider Upload 
   RPV    Restart Provider Upload 
   DSP    Display Progress 
   MALL   Upload all Merged patients 
   PMRG   Pause Merge Upload 
   RMRG   Restart Merge Upload 
   ASU    Active ASUFAC Display 
   PER    EDR Patient File Count Errors 
   TCT    Pt Count for Throttle action 
   THR    Throttle Patient Upload 
  
Select Dental Interface Upload Menu Option: 
 
To verify that the automatic trigger is properly associated with the BPM 
Patient Merge use the programmer’s prompt and check that the ITEM field 
below shows BADE MERGE PATIENT ADT-A40: 
 
TST>D Q^DI 
VA FileMan 22.0 
Select OPTION:    INQUIRE TO FILE ENTRIES 
  
OUTPUT FROM WHAT FILE: PROTOCOL// 
Select PROTOCOL NAME:    BPM MERGE PATIENT ADT-A40     MERGE PATIENT ADT-
A40 MES 
SAGE 
ANOTHER ONE: 
STANDARD CAPTIONED OUTPUT? Yes//   (Yes) 
Include COMPUTED fields:  (N/Y/R/B): NO//  - No record number (IEN), no 
Computed 
 Fields 
  
NAME: BPM MERGE PATIENT ADT-A40         ITEM TEXT: MERGE PATIENT ADT-A40 
MESSAGE 
  TYPE: extended action                 CREATOR: ADAM,ADAM 
  PACKAGE: IHS PATIENT MERGE 
 DESCRIPTION:   This protocol belongs to IHS Patient Merge (BPM), and is 
called when two patients have been merged by the BPM application.  At call 
time, variables DFNFROM and DFNTO are defined. 
  
ITEM: BADE MERGE PATIENT ADT-A40        SEQUENCE: 967 
  TIMESTAMP: 62249,29263 
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Checksums for BADE*1.0*1 
 
Routine Summary 
The following routines are included in this patch.  The second line of each 
of these routines now looks like: 
;;1.0;DENTAL/EDR INTERFACE;**[Patch List]**;AUG 22, 2011 
  
                 Checksum 
Routine         Old       New      Patch List 
BADEASU       8324469   8324469    **1** 
BADECTRL      9018341   9018341    **1** 
BADEECP1      5363046   5363046    **1** 
BADEEVNT      9264613   9264613    **1** 
BADEHL1      19922220  19922220    **1** 
BADEHL2       8972852   8972852    **1** 
BADEHL3      23232922  23232922    **1** 
BADEHL4      17245079  17245079    **1** 
BADEHLI      21115732  21115732    **1** 
BADEHLZ       6429262   6429262    **1** 
BADEMRG       7089061   7089061    **1** 
BADEMRG1      6053912   6053912    **1** 
BADENTEG      2251127   2251127    **1** 
BADEPROV     14288349  14288349    **1** 
BADEPRV1      9673629   9673629    **1** 
BADEVNT1     11549734  11549734    **1** 

Sites should use CHECK^XTSUMBLD to verify checksums. 

After the successful completion of the BADE Patch 1, the site manager should insure 
that all Interfaces that use the Ensemble Interface Engine are operating and 
functioning properly. 

3.2 Ensemble Installation 
There is a separate Ensemble Installation process defined in the document 
EDR_A40PATCH_INSTALLATION_MANUAL.doc indicating that the following 
file EDR_ENSRPMS_A40PATCH.xml must be installed after the installation of 
BADE PATCH 1. 

3.3 Dentrix Enterprise Modification 
The Dentrix Enterprise Software Interface must be modified in the HL-7 MSH 
segment for the outbound DFT message, Piece 4 from RPMS to RPMS-DEN to 
support both the new BADE RPMS PCC Message filer and to support the multiple 
hospital location clinic names associated with a single ASUFAC. The HL7 A40 
inbound message processing must also be turned on. The Dentrix Enterprise Help 
Desk should be contacted at 1-800-372-4346 Opt 4 for Support to assist in making 
these changes.  
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Appendix A:  Ensemble Installation Notes 

A.1 Preface 
The purpose of this document is to provide the user information about how to import 
and update the base version 1.0 IHS BADE package to support the transport of ADT 
A40 Merge event messages between the EDR and RPMS Systems. 

Note: This patch installation must only be applied to an 
environment already running the original BADE0100 
package. If the initial BADE production package is already 
installed, this patch can be applied independently before or 
after the RPMS BADE patch. 

A.2 Introduction 
For over a decade, hospitals and health centers of the Indian Health Service (IHS) and 
numerous tribal health programs have utilized an information system called the 
Resource and Patient Management System (RPMS). The RPMS is a highly integrated 
system consisting of some fifty health care and administrative applications. Virtually 
all of these applications directly interact with one or more, and sometimes many, of 
the other RPMS applications. 

During this same period, IHS and tribal dental programs have made use of the RPMS 
Dental Data System (DDS) as their primary system for maintaining a history of 
individual patient services; contributing dental data to the RPMS electronic clinical 
record; producing provider and department workload data; and contributing statistical 
data to the national data center located in Albuquerque, New Mexico. At many sites, 
data captured in the DDS has also been utilized in the RPMS Third Party Billing 
System. 

With the replacement of the RPMS Dental Data System with an Electronic Dental 
Record (EDR), it is required that RPMS applications interact with the EDR to meet 
the needs of both the Dental Department and the local health program as a whole. 

The IHS Production for the Ensemble Interface Engine (EIE), provides transportation 
of messages between the RPMS system and the EDR system. It accepts DFT_P03 
messages from the EDR system and delivers them to the RPMS system. It accepts 
MFN_M02, ADT_A31 and ADT_A28 messages from the RPMS system and delivers 
them to the EDR system. This patch will allow an ADT A40 merge message to be 
passed via Ensemble in addition to the existing events.  
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If at any point there is an error in receiving a valid EDR or RPMS HL7 message, if 
there is a connection issue between EIE and either system or any other error occurs an 
alert will sent to the appropriate administrators from the EIE. 

A.3 Shutdown Running Production 
This section describes shutting down the running production in order to import the 
changes to support the ADT A40 Merge event being sent from RPMS. 

A.3.1 Accessing the Portal 
The management portal is accessed by launching Internet Explorer (“the browser”) 
and navigating to the following URL: 

http://(EIEserver:port)/csp/ensrpms/BADE.Zen.Home.cls 

Upon entering the URL into the browser, the user will be presented with the EIE 
Login page: 

 

A.3.2 Stop Production 
After logging in with a username with privileges to start and stop the interfaces, click 
the Stop Production Button below. Once the production is stopped, the light should 
turn red. 
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http://(EIEserver:port)/csp/ensrpms/BADE.Zen.Home.cls
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A.3.3 Alternative method for stopping the production 
An alternative method for stopping the production is provided by the Ensemble 
Management Portal. 

From the Ensemble Studio, select File->Utilities->Ensemble Management 

 

Or, from the System Management Portal, select Ensemble Management. 
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If the namespace isn’t ENSRPMS, from the Namespace drop down box choose 
‘ENSRPMS’. 
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The BADE.IHS Production will be listed in the Production area of the screen (just 
below the Stop Production button), click Stop Production. A popup box will ask you 
to confirm stopping the production – click Yes. 

A.4 IHS Production A40 Patch Import 
This section describes the process of importing the IHS production patch into 
Ensemble Studio from an XML document after the production has been stopped. 

A.4.1 Open Ensemble Studio 
From a windows environment right click the Ensemble Cube in the lower right 
corner, select Studio. Enter your login ID and password: 

From a windows environment right click the Ensemble Cube in the lower right 
corner, select Studio. Enter your login ID and password: 
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Select the proper namespace 

If the namespace isn’t ENSRPMS 

Select File->Change NameSpace… 
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Choose the ENSRPMS namespace from the list. 
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A.4.2 Import the IHS production A40 Merge patch  
Select Tools->Import Local… 
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Select the file named EDR_ENSRPMS_A40PATCH.xml on your network or local 
machine, choose open. 

Ensure that all items within the list are selected and the ‘Compile Imported items’ 
options are selected. 

Installation Guide and Release Notes Ensemble Installation Notes 
November 2011 

25 



Dental/EDR Interface (BADE) Version 1.0 Patch 1 

 

Choose OK, when finished compiling a ‘Compilation finished successfully in…’ line 
will appear in the Result pane. 

Note: If errors were encountered, or you did not receive the 
“Compilation finished successfully’ message, go back to 
step 3.2 and make sure you selected the correct namespace 
(RPMSBADE) and that the ‘Compile Imported Items’ 
checkbox is selected on the import screen above. If 
problems persist, please contact the helpdesk for further 
support. 

A.5 Restart the production 
Once the patch has been imported and compiled, we can now go back into the portal 
and restart the production. 

A.5.1 Accessing the Portal 
Access the management portal again as in section 2.0. Launch Internet Explorer (“the 
browser”) and navigating to the following URL: 

http://(EIEserver:port)/csp/ensrpms/BADE.Zen.Home.cls 

Login again to the EIE Login page: 
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A.5.2 Start Production 
After logging in with a username with privileges to start and stop the interfaces, click 
the Start Production Button below and the stoplight should turn green. 
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A.5.3 Alternative method for starting the production 
An alternative method for starting the production is provided by the Ensemble 
Management Portal. 

From the Ensemble Studio, select File->Utilities->Ensemble Management 

 

Or, from the System Management Portal, select Ensemble Management. 
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If the namespace isn’t ENSRPMS, from the Namespace drop down box choose 
‘ENSRPMS’ 
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The BADE.IHSProduction should be listed in the Production area of the screen (just 
below the Start Production button), click Start Production: 

You should then see the following screen or something similar indicating the start of 
the production: 
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Contact Information 

If you have any questions or comments regarding this distribution, please contact the 
OIT Help Desk (IHS). 

Phone: (505) 248-4371 or (888) 830-7280 (toll free) 

Fax: (505) 248-4363 

Web: http://www.ihs.gov/GeneralWeb/HelpCenter/Helpdesk/index.cfm 

Email: support@ihs.gov 

http://www.ihs.gov/GeneralWeb/HelpCenter/Helpdesk/index.cfm
mailto:support@ihs.gov
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